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1. About Kernel for OST to PST 

Welcome to the user manual for Kernel for OST to PST software, the most efficient and user-friendly email conversion 
software that helps in converting emails and other items of OST files to PST. Apart from the functionality to convert OST 
file data and save it as a PST file, the software also provides options to save file items in email servers, webmails, Office 
365 and more. 

1.1 Using this Manual 

This user manual is intended to guide users with the complete working of Kernel for OST to PST software. We suggest 
that first time users should read this user manual completely and carefully before proceeding to use the software. 
However, if you are an experienced user, you can use the table of contents to find out information pertaining  to the tasks 
that you require to perform by using Kernel for OST to PST. You can use the table of contents to navigate through 
different sections of this user manual.  

1.1.1 List of Abbreviations 
 

Certain acronyms have been used throughout this manual. For a clear understanding of the content of this user 
manual, please go through the list mentioned below, before reading the manual.  

 

• OST or .OST: Offline Storage Files 

• PST or .PST: Personal Storage Files 

• EML or .EML: Electronic Mail (Outlook Express) 

• DBX or .DBX: Email Folder (Outlook Express) 

• RTF or .RTF: Rich Text Format 

• MS: Microsoft 

• RAM: Random Access Memory 

• MB: Mega-Byte 

• GB: Giga-Byte 

 

1.2 Kernel for OST to PST 
 

One of the most comprehensive and dynamic utility, Kernel for OST to PST, has been launched to convert inaccessible, 
corrupted, damaged, or deleted OST files to PST. The software performs flawless OST file conversion operation because 
of the advanced and intelligent algorithms and then saves the recovered OST data files in the most popular file format of 

MS  Outlook i.e. PST. In  addition,  the Kernel for OST to PST software converts the OST file into the MS Outlook Express 
supported .DBX file; it also offers versatile alternatives to store the recovered OST email items on various email servers or 
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web mails. 
 
Kernel for OST to PST is proficient in recovering the OST files that were damaged or corrupted because of a hard drive 
failure, exchange server crashes, virus attacks, accidental deletion, or abrupt system shutdown. 
 

The Kernel for OST to PST software securely converts all the OST data items like Notes, scheduled tasks, appointments, 
Calendar entries, Journals, Drafts, Deleted Items, etc. and remarkably retains the properties, formatting, and email 
metadata like To, Subject, Cc, Bcc, From. 
 

1.2.1 Advanced Saving Options 
The Kernel for OST to PST software embeds various alternatives for saving the OST files. According to the requirement, 
you can save the data files in many latest available formats and can migrate email items to the various popular services 
and applications. The detailed descriptions of saving options are mentioned in the following key points: 

 

• Single File Formats - PST file (MS Outlook), DBX file (Outlook Express), and MBOX file. 

• Multiple File Formats - MSG file, EML file, TXT file, RTF file, HTML file, MHTML  file, and PDF file 

• Email Servers - GroupWise, IBM Domino (Lotus Domino), Microsoft Exchange Server, and Office 365. 

• Web-Based email Clients - Gmail, Google Apps, Yahoo, AOL, 
Hotmail.com/Live.com/Outlook.com, iCloud, and company IMAP account. 
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1.3 Salient Features 
 

Kernel for OST to PST is advanced software, which is equipped with a varied range of features to help you recover OST 
file data and convert the same to PST. The following key  points  reflect the important feature of the software: 
 

• Guarantees the recovery of deleted emails, folders, appointments, tasks, notes, calendar, journals, drafts, 
emails, etc. 

 

• Recovers emails from OST files even if the Exchange profile is not available 

• Recovers permanently deleted or accidentally deleted emails 

• Retains email metadata: To, From, Cc, Bcc, Subject, Time, Date,  etc. 

• Facility to save the recovered OST files to OWA or Office 365 cloud application 

• Offers options for storing the recovered OST files on email servers like Novell GroupWise, IBM 
Domino, MS Exchange Server, and company IMAP account 

 

• Capable enough to recover complete attachments, zipped attachments, images, etc. 
 

• Offers unique Find functionality that helps in carrying out the fast and precise search operation of OST email 
items 

 

• Allows saving of the recovered OST email items to the popular web-based email clients like Gmail, AOL, Hotmail, 
Google Apps, Yahoo, iCloud, Live Mail, and Outlook 

 

• Integrated with Save and Load Snapshot features 

• Provides advanced email filter options for better segregation of email items on the basis of date- range 
 

• Restores formatting, properties, and structure of emails 

• Offers multiple saving options, which includes various file formats like PST, MSG, MBOX, TXT, RTF, HTML, 
MHTML, DBX, IMAP, and EML 

 

• Incorporated with File Analysis Report generation facility that dynamically tracks parameters like mail flow 
density by date or senders, total item types, and interaction between users 

 

• Allows you to save the list of retrieved emails in HTML format 

• Displays recovered emails in tree-like structure because of its embedded preview technology 
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1.4 Who Should Use This Software? 
 

The advanced features of Kernel for OST to PST to recover OST file data makes the software a preferred choice of system 
administrators, who handle email recovery tasks in organizations. This OST to PST conversion tool eases the conversion 
of OST files to PST files as it allows you to restore and save OST file items to other formats like PST, DBX, EML or MSG file 
format. 

2. Getting Started 
 

Now that you have understood the features and potential of Kernel for OST to PST, you are ready to get hands-on experience 
of the software. To start the process of .ost file recovery and .ost to .pst conversion. First of all, you will need to download 
and install the software. However, it is strongly recommended that before installing Kernel for OST to PST, you should go 
through the installation pre-requisites of the software to ensure that your system is properly configured to run the 
software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for OST to PST can be broadly classified into two major 
categories – Hardware requirements and Software requirements. 

 

2.1.1 Hardware Requirements: 
 
The hardware requirements for installing the software are as follows: 
 

• Pentium Class Processor 

• 64 MB RAM (128 MB Recommended) 

• 50 MB for Software installation 

• Windows 9x/ME/NT/2000/XP/Vista/7/8/8.1/10 

• Disk Space - Enough space to store the repaired files 
 

 

2.1.2 Software Requirements: 
 
The software requirements for installing the software can further be grouped into two categories – Operating system 
requirements and application version requirements. The requirements are as follows: 

        2 .1.2.1 Operating System Requirements 

 Supported operating systems (32 and 64-Bit Versions): 
 

 

 You should have at-least 15 MB of free disk space if you want to convert and save a 15 MB .ost file. 
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• Windows  10 • Windows 8/ 
Windows 8.1 

• Windows 7 • Windows 2000 

• Windows XP • Windows 9x 

• Windows 2003 • Windows Vista 

2 .1.2.2 Supported Application Platforms 

 
• Supported Exchange Server versions: Exchange Server 5.0, 5.5, 2000, 2003, 2007, 2010, 2013, 2016 and 2019 

 

• Supported MS Outlook versions: Microsoft Outlook 97, 98, 2000, 2002, 2003, 2007, 2010, 2013 (both 32 and 
64 bits), 2016 and 2019 

 

• Supported Outlook Express platforms- MS Outlook Express version 5.0/5.5/6.0 

 

2.2 Downloading Kernel for OST to PST for the First Time 
 

After inspecting the computer’s minimum system requirements for Kernel for OST to PST, you can download and install 
the software on your computer. The formalities for purchasing the full version of the software can be initiated from any 
one of our authorized resellers– Element5, and Avangate. 

 

If you want to try and run Kernel for OST to PST even before buying it, then you are required to download the evaluation 
version from the following link: 

 

https://www.nucleustechnologies.com/download-ost-pst-conversion.php 
 

 

 

2.3 Install Kernel for OST to PST 
 

After downloading the installer or .exe file of Kernel for OST to PST, execute the following steps to install the software: 
 

1. Double-click the Kernel for OST to PST software installer file. 
 

2. Follow the on-screen instructions. When the installation process completes, “Completing the Kernel for OST to 
PST Setup Wizard” message appears on the software installation screen. 

 

3. Click the Finish button to complete the software installation and launch the software. 

 Kernel for OST to PST conversion free tool allows you to recover data from an infected or damaged 
OST file, but restricts you from saving not more  than 25 email items  of each folder. 

https://www.nucleustechnologies.com/download-ost-pst-conversion.php
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2.4 Start Kernel for OST to PST 
 

To start Kernel for OST to PST: 

• Click the Start>All Programs>Kernel for OST to PST>Kernel for OST to PST. 

 
Alternatively, you can launch Kernel for OST to PST by double-clicking the shortcut icon available on the desktop and 
Quick Launch icon. 
 

2.5 Uninstall Kernel for OST to PST 
 

You may need to uninstall and re-install Kernel for OST to PST. You can uninstall Kernel for OST to PST in two different 
ways: 
 

       2.5.1 Uninstall from the Windows Start menu 
 
To uninstall Kernel for OST to PST from the Windows Start menu: 

1. Click the Start>All Programs>Kernel for OST to PST>Uninstall Kernel for OST to PST. 
 
A warning message will be displayed. 

 
2. Click Yes to uninstall Kernel for OST to PST. 
 

        2.5.2 Uninstall from Control Panel 
 
You can alternatively uninstall Kernel for OST to PST from the Control Panel by performing the following steps: 

1.  Click the Start Menu>Control Panel and then double click the Add or Remove Programs icon. 
 

2. Select Kernel for OST to PST and click Remove. A warning message will be displayed. 

 
3. Click Yes to uninstall Kernel for OST to PST. 
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3. Software Interface 
 

After the successful installation of Kernel for OST to PST on your computer, you can start using the software, but before 
that, let us get acquainted with the software interface. 

  3.1 Menu bar 
 

The menu-bar comprises of four menus, divided into several menu items, to assist users in retrieving OST file data. The 
menus are: 
 

• File Menu 

• View Menu 

• Find Menu 

• Help Menu 

 

3.1.1 File Menu 
 
The File menu comprises of three menu items. Select File, Save, and Exit to help users in performing functions 
described below: 

 
 

 
 
 
 
 
 
Menu items in the File menu: 

F igure 3.1: File Menu 

 

 
F ield Name 

 
F ield Description 

 
Select File 

 
Opens the “Source File Selection” dialog so that you can select or 
search source OST file 

 
Save 

 
Opens “Select Output Type” dialog so that you can select the required 
saving option 

 
Exit 

 
Closes Kernel for OST to PST software 



© KernelApps Private Limited 
 

            Kernel for OST to PST 

 

 

            Kernel for OST to PST User Guide 

3.1.2 View Menu 
 
View menu expands over the Status bar to assist the user: 

 
 
 
 
 
 
 
Menu Items in the View menu: 

F igure 3.2: View Menu 

 

 
F ield Name 

 
F ield Description 

 
Status Bar 

 
                       Select to show or hide Status Bar 

 
Task Bar 

 
Select to show or hide Task Bar 

 

3.1.3 Find Menu 
 
Find menu expands over Find Message bar to assist the user: 
 

F igure  3.3: Find Menu 

 

 
F ield Name 

 
F ield Description 

 
Find Message 

 
Allows you search messages from OST file 

folders 
 

3.1.4 Help Menu 
 
The Help menu comprises two menu items. 

F igure  3.4: Help Menu 



© KernelApps Private Limited 
 

            Kernel for OST to PST 

 

 

            Kernel for OST to PST User Guide 

Menu items in the Help menu: 
 

 
Field Name 

 
Field Description 

 
About 

 
Displays version and support related information about 

the software 

 
Software 

Help 

 
Displays User’s Help Manual for Kernel for OST to 

PST 

 

3.2 Tool-bar 
 

Toolbar is located just below the menu-bar of the software interface. It offers a convenient and interactive method for 
performing varied functions that are otherwise performed by using the Menu Bar. The following buttons are available in 
the toolbar, and each button has its respective use: 

 

 
B utton 

 
B utton Name 

 
D escription 

 

 

 
Select File 

 
Opens “Source File Selection” dialog to browse or 

locate source corrupt OST file 

 
 

 

 
Save 

 
Opens “Select Output Type” dialog so that you can 

select required saving options 

 
 

 

 
 

Save Snapshot 

 
 

Saves a snapshot of the conversion process to the 
desired location 

 

 

 
Load Snapshot 

 

Loads a previously saved snapshot from specified   

location 

 

 

 
 

Find 

 
 

Allows you search required mails from selected OST 
file 

 
 

 

 
Help 

 
 Displays User’s Help Manual for Kernel for OST to PST 
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3.3 Left Pane 
 

Left Pane of Kernel for OST to PST enhances the viewing experience of the OST file recovery process as it renders the 
preview of recovered OST email items in a tree-like structure. You can navigate through the various folders and files that 
were extracted after an extensive OST file recovery process. The  retrieved files and folders are displayed like this in the 
Left Pane: 

 

 

F igure  3.5: Left Pane 

 

In addition to this, there are some additional buttons in the Left Pane, which are mentioned below in the 
following table: 
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B utton 

 
B utton Name 

 
B utton Description 

 

 

 
 

Calendar 

 
 

Shows Calendar View in Right Pane 

 

 

 
 

Contacts 

 
 

Shows Contact and related information in Right Pane 

 

 

 
 

Tasks 

 
 

                               Shows Task in the Right Pane 

 

 

 
 

Journal 

 
 

Shows Journals in the Right Pane 

 

 

 
 

Notes 

 
 

Shows Note in the Right Pane 

 

 

 
 

Up 

 
 

Displays the Folder Path pane in the Left Pane 

 

 

 
 

Down 

 
 

Hides the Folder Path pane in the Left Pane 

 
 

 

 

3.4 Right Pane 
 

Right Pane of Kernel for OST to PST displays the email items in the folder or file selected from the  Left Pane. The Right 
Pane is again divided into two different panes (as shown in the image below): 
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F igure  3.6: Right Pane 

 

   Display Pane - Enlists the email items available in the folder you selected from the Left Pane: 
 

 
 

B utton B utton Name B utton Description 

 

 

 
Save list information 

to html file 

 
Allows you to save the list information in 

HTML format 

 

 

 
Stop current process 

 
Stops the current process 

 

 

 
Show/hide calendar 

view 

 
Shows or hides the calendar view in Display 

Pane 

 

 

 
Show one day 

 
Shows the calendar entries for a particular day 
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Show working days 

 
Shows the calendar entries for five days 

 

 

 
Show weekdays 

 
Shows the calendar entries for the entire week 

 

 

 
Show month days 

 
Shows the calendar entries for the entire month 

 

 

 
Save in MSG 

 
Saves the listed email items in MSG format 

 

 

 
Save in EML 

 
Saves the listed email items in EML format 

 

 

 
Save in TXT 

 
Saves the listed email items in TXT format 

 

 

 
Save in RTF 

 
Saves the listed email items in RTF format 

 

 

 
Save in PDF 

 
Saves the listed email items in PDF format 

 

 

 
Save in HTML 

 
Saves the listed email items in HTML format 

 

 

 
Save in MHTML 

 
Saves the listed email items in MHTML format 

 

 

Preview Pane- Shows the preview of contents of email items selected in Display Pane 
 

Task Pane – Displays the versatile Save Options along with the display of the File Analysis Reports section. The Task 
Pane is further sub-divided into five different sections that are mentioned in the following bullet points: 
 

• Saving Options (Single File) – PST file, DBX file, and MBOX file 

• Saving Options (Multiple Files) – MSG file, EML file, TXT file, RTF file, HTML file, MHTML file, and PDF file 

• Saving Options (Email Servers) – Office 365, GroupWise, IBM Domino (Lotus Domino), and Microsoft 

Exchange Server 

• Saving Options (Web Based Email Apps) – Gmail, Google Apps, Yahoo, AOL, 

Hotmail.com/Live.com/Outlook.com, iCloud, and Company IMAP Account 
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• File Analysis Reports – Total item types, Mail flow density by date, Mail flow density by senders,  and Interaction 
between users 

 

F igure  3.7: Task Pane 
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4. Convert OST to PST 
 

Kernel for OST to PST allows you to retrieve data from inaccessible OST files and convert the recovered data in Outlook or 
Outlook Express file format so that the recovered data can be accessed easily. The software quickly converts all the OST 
data items to Outlook supported PST files. 

 

4.1 Quick Scan 

Using Kernel for OST to PST, you can flawlessly convert OST to PST by extracting the data from inaccessible OST files. The 
software creates a new PST file with the extracted data from the OST file and saves the same at a user-defined location. 
Mentioned below are the steps to convert OST to PST using Kernel for OST to PST software: 

 

1. Click Start > All Programs > Kernel for OST to PST > Kernel for OST to PST to launch the software. The 

main window of the software appears: 
 

F igure  4.1: Welcome Screen 

 

Note: The “Source File Selection” dialog appears by default. 

 

2. Click the Browse button to select the OST file, if you know the location of the OST file. However, if you do not know 
the exact location of OST file, click the Search button, “Search OST file(s)” dialog appears 
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F igure  4.2: Search OST Files(s) 

 
3. Click the Browse button to select the folder where you want to search for the OST file. After selecting the required 

drive, click the Search button. 
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F igure  4.3: Scanning Drive  for OST file(s) 

 

The software will start searching for the OST file. 
 

4. The software will enlist the OST files found in the selected drive. Select the required file and click the OK button. 
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F igure  4.4: Available  OST files enlisted 

 

5. The selected OST file will get enlisted in the “Source File Selection” dialog: 
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F igure 4.5: Select corrupted source OST file dialog 

 

 

 

6. Click the Next button, and the Process Information page will appear. It will display all options available while executing 
OST to PST conversion process:

 Note: Alternatively, to load a previously saved snapshot, select Load Snapshot Only checkbox and click Next to 
load the snapshot. 
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F igure  4.6: Process Information page 

 

7. Click Finish to start the .ost file scanning/repair process. 
 

F igure  4.7: Repairing Process dialog 
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8. After the scanning process completes, the recovered items will get enlisted in the Left Pane, select any folder to 
view the contents in Right Pane: 

 

F igure  4.8: Preview Window 

 

9. Select the folder from the Left Pane and click the Save button to proceed with saving the recovered emails. "Select 
Output Type" dialog appears: 



© KernelApps Private Limited 
 

            Kernel for OST to PST 

 

 

            Kernel for OST to PST User Guide 

 

F igure  4.9: Select Output Type 

 

10. Select the required format on which you wish to view the recovered data and click the Next button to continue. 
 

11. Define the desired location where you wish to save the newly created data file. The software will start saving the 
data at the desired location: 
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F igure  4.10 Saving Emails 

 

12. After the items are saved, the software displays the following message: 
 

F igure  4.11: Saved Files 
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5. Saving Options 
 

Now that you have retrieved the data from inaccessible OST files, you must save the recovered data. Kernel for OST to 
PST offers the following distinct saving options to save and access the recovered OST data: 
 

F igure  5.0: Saving  Options Window 

 

• PST File (MS Outlook): This option allows you to save recovered email data in MS Outlook. 

• DBX File (Outlook Express): This option lets you to save recovered email data in formats supported by 

Outlook Express. 

• MBOX File: This option permits you to save the recovered email data in the MBOX file format. 

The software also allows user to save recovered individual email items in EML, MSG, TXT, RTF, PDF, HTML, and 
MHTML formats. Apart from this, you can migrate the recovered email items to the popular email servers and 
Web-based email applications. You can initiate this migration facility by clicking the Email Servers or Web-Based 
email clients sections. 
 

Make the selection of a suitable file format for saving the OST file data and click on the "Next" button. 
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As you click on the "Next" button, the "Select Filter(s)" dialogue box appears asking to define the filters and to save 

specific data. 
 

F igure  5.1: Select Filter (s) dialog 

 

You can save emails by providing suitable options among these: 
 

Field Name Field Description 

From 
 

This option will save (all/only/discard) the emails sent from a particular individual 

To This option will save (all/only/discard) the emails send to a particular individual 
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Subject 
 

This option will save (all/only/discard) the emails featured with same email subject 

Folder 
Name 

 

This option will save (all/only/discard) the emails of the particular folder name 

Item Type 
 

This option will save (all/only/discard) the email data based upon its types like 
Journal, Task, Notes, Contacts, etc. 

Date 
Range 

This option will save (all/only/discard) the emails of the selected date range(s) 

 

 

5.1 Save in PST 
 

Select the PST file (MS Outlook) option to save the recovered data in PST file format. In order to save the recovered data in 
PST file format, you can follow the instructions given below: 

 

1. After the conclusive recovery of OST email items, select the PST file (MS Outlook) option and click  the Next button 
in the “Select Output Type” dialog box: 

 

F igure  5.2: Select Output Type dialog 
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Option 

 
Description 

 
PST File (MS Outlook) 

 
Select this option to save email items in 

individual PST files. These PST files can be 

opened with MS Outlook. 

 

 

2. The selection of PST file (MS Outlook) option displays the “Select Filter (s)” dialog. Select the desired filter options 
and then click the Next button to proceed. 

 

3. After configuring the desired filter options, the "Manage Recovered PST" dialog box appears. 
 

F igure  5.3: Manage Recovered PST dialog 
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Here you can split the large-sized PST file using the various split options: 
 
 
 

S plit Options F unctions 

 
Do not split file 

 
Select this option if you want to create a 

single PST file 

 
Split file after 1 GB 

 
Select this option to split the pst into 

equal 1 GB files 

 
Split file after 1.5 GB 

 
Select this option to split the pst into 

equal 1.5 GB files 

 
Split file after 2 GB 

 
Select this option to split the pst into 

equal 2 GB files 

 
Split file after 2.5 GB 

 
Select this option to split the pst into 

equal 2.5 GB files 

 
Split file after 3 GB 

 
Select this option to split the pst into 

equal 3 GB files 

 
Split file after 3.5 GB 

 
Select this option to split the pst into 

equal 3.5 GB files 

 
Split file after 4 GB 

 
Select this option to split the pst into 

equal 4 GB files 

 
Split file after 5 GB 

 
Select this option to split the pst into 

equal 5 GB files 

 

In addition, there is an option of adding a prefix to the Store Name, if you enable this option and type the required prefix in 
the Store name prefix text box, then the recovered Store name will appear with the provided prefix in Outlook. 
 

4. After clicking the Next button in the Managed Recovered PST dialog, the Select Destination Path dialog gets 

displayed. 
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F igure  5.4: Select Destination Path 

5. Click the Browse button, as the Browse for Folder window appears. Select the desired location to save the 
recovered data, and then click the OK button. 

 

F igure  5.5: Browse for Folder 



© KernelApps Private Limited 
 

            Kernel for OST to PST 

 

 

            Kernel for OST to PST User Guide 

 

6. Click the Finish button to initiate the saving process: 

 

F igure  5.6: Saving Process 

 

After the saving gets accomplished, the software displays the following success message: 
 

F igure  5.7: Saved Files dialog 

 

To access the newly created PST file, click on the link given in the dialog box. 

 Note: Select the “Exclude deleted items while saving” checkbox, to exclude saving deleted items from repaired 
OST to output PST file format. 
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5.2 Save in MSG 
 

In order to save the recovered data in the MSG file format, you can follow the instructions given below: 
 

1. After the successful recovery of data files, email items are enlisted in the Left Pane, click the Save 

button in the Toolbar for initiating the saving process. 
 

2. Click the Save button, and as the Select Output Type dialog gets displayed, select the MSG file 
option, and then click the Next button. 

 

F igure  5.8: Select Output Type dialog 

 

 
O ption 

 
D escription 

 
MSG file 

 

Select this option to save email items in 
individual MSG files. These MSG files can be 

opened with MS Outlook by either double-

clicking on them or by dragging them to MS 

Outlook 



© KernelApps Private Limited 
 

            Kernel for OST to PST 

 

 

            Kernel for OST to PST User Guide 

3. Proceed with the selection of various filter options, and as the Select Destination Path dialog appears on the screen, 
click the Browse button to locate the place for saving the MSG file that subsequently displays the Browse For Folder 
dialog box. 

 

F igure  5.9: Select Destination Path 

 

F igure  5.10: Browse For  Folder dialog 
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4. Click the OK button in the Browse for Folder dialog after assigning the folder to save the MSG files. 
 

5. Click the Finish button to initiate the saving process 
 

F igure  5.11: Saving Process 

 

 
After the saving process gets completed, the software displays the following success message:  

 

F igure  5.12: Saved in MSG 

 

To access the newly created MSG file, click on the link given in the dialog box. 
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5.3 Save in DBX 

Select the DBX File (Outlook Express) option to save the recovered data in the DBX file format. Mentioned below is 

the process to save the recovered items in DBX file format: 

1. After the recovered data gets listed in the Left Pane, click the Save button in the Toolbar to initiate the saving process. 

2. As the Select Output type dialog appears on the screen, to save the recovered data in Outlook Express, select the DBX 

file (Outlook Express) option and click the Next button. 

 

 

F igure  5.13: Select Output Type dialog 

 
 
 

 
Option 

 
Description 

 
DBX File (Outlook Express) 

 
Select this option to save the recovered data in 

the DBX file format 
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3. Apply the desired filter options, and then click the Next button. 
 

 

F igure  5.14: Select Destination Path dialog 

4. As the Select Destination Path dialog box, click the Browse button, and the Select Outlook Express Folder dialog 

appears. 

5. Configure the desired saving location of the DBX file. 
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F igure 5.15: Select Outlook Express Folder dialog 

 

 

6. Click the Finish button to initiate the saving process: 
 

F igure  5.16: Saving process 

 

7. After the saving process gets completed, the software displays the following success message: 

 Select the "Exclude deleted items while saving" checkbox, to exclude saving of the deleted items of recovered 
OST to OE folder. 
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F igure  5.17: Success message dialog 

 

 

5.4 Save in EML 
 

Select the EML file option to save the recovered data in individual EML files. Mentioned below is the process using which 

you can save the recovered items in EML file format: 

1. After the recovered data is enlisted in the Left Pane, click the Save button, which displays the Select Output type dialog 

box. 

2. To save the recovered data in EML file format, select the EML file option. 
 

F igure  5.18: Select Output Type dialog 
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Option 

 
Description 

 
EML file 

 
Select this option to save the recovered email 

items in individual EML files. Drag or double-click 

on these EML files to view their contents in 
Outlook Express 

 

3. After selecting the EML file option, click the Next button, and then proceed by applying the desired filter options 
which displays the Select Destination Path dialog box. 

 

 

F igure  5.19: Select Destination Path dialog 

 
4. Select the Exclude deleted items while saving checkbox, to exclude saving the deleted items of recovered OST to EML. 

5. In the Select Destination Path dialog, click the Browse button that displays the Browse For Folder dialog box. 
6. Set the desired saving location for saving the recovered EML file at the desired location. 
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F igure  5.20: Browse For  Folder dialog 

 

7. Click the Finish button to initiate the saving process: 

 

 

F igure  5.21: File  saving process 

 
8. After the saving process gets completed, the software displays the following success message: 
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F igure  5.22: Saved Files dialog 

 

6. File Analysis Reports 
 

The Kernel for OST to PST software is also integrated with the facility to showcase the graphical File Analysis Reports 
corresponding to the four different parameters. The user can invoke the File Analysis Reports option by clicking the desired 
options in the File Analysis Reports section of the Task Pane. 
 
These reports can be generated on the basis of the following attributes: 
 

• Total item types 

• Mail flow density by date 

• Mail flow density by senders 

• Interaction between users 
 

These reports can be generated after adding and repairing the OST files. To view the reports, click the required report 
name in the bottom of the Task Pane, after repairing the respective OST file. 

 
 

6.1 Total item types 
 

The Total item types bar-graph shows a categorized view of all message classes. Users can view the count of each 
class in the graphical view or the tabular view. 
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F igure  6.1: Total item types report 

 

6.2 Mail flow density by date 
 

The Mail flow density by date graph report shows the mail flow density on different range of dates. It 
shows the number of messages on different dates in the graphical bar-graph format. 
 

F igure  6.2: Mail flow density by  date report 
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6.3 Mail flow density by senders 

The Mail flow density by senders graph report categorizes emails according to their senders. You can 
view the number of emails sent by various senders for analysis purposes. 
 

F igure 6.3: Mail flow density by senders report 

 

6.4 Interaction between users 
 

The Interaction between users graph shows the number of mail interactions amongst various users. The 
interaction between a particular sender and receiver can easily be noted from this graph. 
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F igure 6.4: Interaction between users report 

 

7. Troubleshooting 
 

This section deals with your generic and specific queries pertaining to using Kernel for OST to PST. 

 

7.1 Common Issues 
 

Why does Kernel for OST to PST have limitations in the evaluation copy? 
 

Although you can use Kernel for OST to PST evaluation version for free and experience the capabilities of the 
software, there are certain features that are not available in the evaluation version. By using the evaluation 
version of Kernel for OST to PST, you can repair corrupt .ost files; however, you cannot save more than 25 
email items of each folder. 

 

7.2 Frequently Asked Questions 
 

How to Buy Kernel for OST to PST? 

 

You can buy Kernel for OST to PST online at https://www.nucleustechnologies.com/buy-ost-pst-

recovery.php  

I  have lost my full version for Kernel for OST to PST. Can you help me? 

https://www.nucleustechnologies.com/buy-ost-pst-recovery.php
https://www.nucleustechnologies.com/buy-ost-pst-recovery.php
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Please email us at sales@nucleustechnologies.com. Please include your name, address, email 

address, and order confirmation number (if you have it). We will be happy to help you.  

I  cannot view the Status Bar. How can I view it? 

 
The Status Bar in Kernel for OST to PST is by default visible. It might have become invisible by 
someone accidentally changing the settings. 
Click View>Status Bar to make the Status Bar visible again. 

8. Conclusion 
The User Guide is easy to understand and helps to recover corrupt and inaccessible OST files and save it to 

Outlook PST file. Learn more about the product and its benefits here:  

https://www.nucleustechnologies.com/ost-to-pst-converter.html 

9. Support 
Connect to our experts immediately while facing any issues during installation, configuration, or associated  

matters: 

• 1-866-348-7872 

• 0-808-189-1438 

Additionally, you can connect with us at https://www.nucleustechnologies.com/Contact.html  to submit 

your query, or chat with one of our support team. 

Moreover, you can write to us at the following email addresses: 

• sales@nucleustechnologies.com  (for Sales Queries) 

• support@nucleustechnologies.com  (for Support Queries) 

10. Copyright 
KernelApps Private Limited accompanied Installation & configuration manual, and documentation is 

copyright of KernelApps Private Limited, with all rights reserved. Under the copyright laws, this user 

manual cannot be reproduced in any form without the prior written permission of KernelApps Private 

Limited. No Patent Liability is assumed, with respect to the use of the information contained herein.  

© KernelApps Private Limited. All rights reserved. 

-end- 
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